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HHOOWW--TTOO
Scritto da Luca De Marini

Bene, sappiamo che uno dei punti deboli di GIMP è la mancanza di un consistente numero di plugin. Photoshop è l'unico software che tutti amano e
utilizzano quando si devono applicare ogni sorta di modifica/ trasformazione per le immagini, o quando si deve creare una grafica con l'aiuto di ben
specifici plugin. Per Photoshop ci sono centinaia di plugin. Questo è un problema per The Gimp? Non proprio.

UUSSAARREE II PPLLUUGGIINN DDII PPHHOOTTOOSSHHOOPP

IINN GGIIMMPP

Molti di voi forse non lo sanno, ma
GIMP supporta un gran numero di
plugin di Photoshop, sia su Windows
che su Linux grazie a quel
meraviglioso strumento chiamato
PSPI. Ora, vediamo come utilizzarlo e
cosa si può fare con il nostro nuovo
giocattolo, pagando nulla,
naturalmente!

Cominciamo

Prima di tutto abbiamo bisogno di
installare WINE sul nostro Linux (in
Ubuntu, cercare il pacchetto WINE in
Synaptic), quindi abbiamo bisogno di
GIMP e PSPI, naturalmente. Abbiamo
anche bisogno di almeno un plugin di
Photoshop. Per iniziare ho scaricato
due plugin, uno commerciale e uno
freeware. Il primo è Designer Sextet
dalla Flaming Pear e per il secondo il
plugin, quello freeware, ho scelto

Caravaggio da Xero Graphics.

Installazione PSPI e plugin per

Photoshop

È il momento di installare PSPI su
GIMP. Quello che segue è un estratto del
sito PSPI:

"I pacchetti per Linux comprendono
tre file: README.linux pspi, un piccolo
script di shell pspi.exe.so, il binario che
gira in WINE".

Copiate pspi e pspi.exe.so nella vostra
cartella personale GIMP plug-in, di solito
~/.gimp-2.2/plug-ins.

Quando si esegue GIMP comparirà un
messaggio di avvertimento "wire_read():
errore", come se pspi.exe.so non
potesse essere avviato direttamente.
(Lo script PSPI può tuttavia essere - e
per GIMP infatti è a tutti gli effetti - un

plug-in di GIMP.) Questo avviso è
innocuo (GIMP ignora quel file), ma
se si vuole evitarlo, bisogna
spostare pspi.exe. da qualche altra
parte e modificare lo script PSPI
perchè punti alla sua nuova
posizione.

Dopo l'avvio di GIMP, cliccate su
Xtns > Photoshop Plug-in Settings e
inserire la cartella in cui si intende
conservare il plug-in di terza parte
di Photoshop (file .8bf) che si
desidera utilizzare in GIMP.

È preferibile utilizzare una
cartella vuota e quindi installare
(copiandoli) i plug-in di Photoshop
uno alla volta, verificandoli
costantemente. Non è molto utile
andare di fretta e installare una
grande quantità di plug-in di
Photoshop in una sola volta e

https://www.gimp.org
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essere certi che tutti lavoreranno
sotto PSPI.

Così ho fatto quello che c'era
scritto nelle istruzioni e ho anche
copiato i miei Plugins appena
scaricati in una cartella nella mia
home, che ho chiamato ~/.gimp-
2.2/psplugins.

Ricordatevi che questa cartella di
GIMP cui ci si riferisce è una cartella
nascosta, quindi, si dovrà impostare
il vostro browser di file in modo che
esso mostri i file nascosti. Nel mio
caso, uso GNOME e Nautilus e vedo i
file nascosti utilizzando il menù di
Nautilus Visualizza> Visualizza file
nascosti.

Impostazione di GIMP

Seguendo la guida, avvio GIMP e si

blocca per alcuni secondi analizzando il
plugin appena installato: ma una volta

che GIMP è
caricato,
imprevedibilm
ente non
ottengo alcun
messaggio di
errore (la
guida PSPI
avvertiva che

poteva verificarsi un errore, ma non ne
ho visti). Al momento tutto funziona
bene. Procedendo con le impostazioni,
ho aperto il menu di GIMP Xtns >
Photoshop Plug-in Settings e questa
finestra mostra:

Premete il pulsante Nuovo (nella mia
schermata è il foglio di carta bianco con
sopra una stella arancione, in alto a
sinistra) e scegliete il percorso in cui
mettere i plugin di Photoshop. Nel mio
caso sappiamo che è

/home/darkmaster/.gimp-
2.2/psplugins. Premete il pulsante
OK e comparirà un messaggio di
avvertimento che il nuovo plug-in
verrà caricato al prossimo riavvio di
GIMP.

Test dei nuovi Plugins PS

Per completare l'operazione ho
chiuso e riaperto The GIMP. Anche
ora non ho ancora ricevuto alcun
messaggio di errore. Ho poi
caricato un'immagine dal mio disco
fisso e quindi ho cliccato sul menu
Filtri. Il plugin sono nella parte
inferiore del menu.

Testiamoli! Funzioneranno?
Comincio con Flaming Pear>
Aetherize e wow... funziona! Ecco lo



10

screenshot!

Adesso è il turno di Caravaggio e
wow, funziona anche questo!
Un'altra schermata per la stampa:

Questo è il risultato dopo aver
applicato il filtro Caravaggio (a
destra). Non sembra un vero e
proprio dipinto? Questo plugin
Caravaggio è eccellente ed è
freeware.

Conclusioni

Così ho provato due plugin di

Photoshop presi a caso dalla rete e
entrambi hanno funzionato. Immagino
che grazie a Wine, la compatibilità già
molto elevata migliori ad ogni release...
Che cosa posso dire ora? Divertitevi e
dite addio a uno dei più deprecati difetti
di GIMP: la mancanza di validi plugin
professionali! Se avete da spendere, è
possibile acquistare e utilizzare plugin
professionali come quelli forniti da Alien
Skin su Linux con The GIMP e PSPI!

Valutazione e Credits

Ok, non è una recensione, ma
nondimeno do a questa estensione PSPI
per GIMP un 5 su 5. Fa ciò che promette
di fare e aggiunge funzionalità di vitale

importanza a The GIMP. Un grande
ringraziamento va al progetto
WINE, al team PSPI e ai creatori di
GIMP.

Per ulteriori informazioni su PSPI:

http://url.fullcirclemagazine.org/1fa7
e2

http://url.fullcirclemagazine.org/1fa7e2
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HHOOWW--TTOO UUSSAARREE  GGIIMMPP  --  PPaarrttee  11
Scritto da Ronnie Tucker

Per prima cosa, aprite GIMP, e 
date un'occhiata veloce alla 
sua impostazione. Notate che 

al primo avvio, GIMP potrebbe 
apparire leggermente diverso dalla 
mia impostazione (sotto). Come 
inizio, parlerò brevemente 
dell’impostazione di GIMP.

In alto a sinistra vediamo gli 
strumenti e in basso a sinistra 

Questa serie di lezioni, basate su GIMP 2.4.2, non esploreranno ogni centimetro quadrato di GIMP, dato che sarebbe necessario un libro 
(e infatti ce ne sono in giro parecchi), ma alla fine sarete abbastanza esperti in GIMP da creare qualsiasi cosa, dal semplice striscione 
web a grandi poster idonei alla stampa professionale.

vediamo le opzioni per lo strumento 
scelto (Paintbrush, in questo caso). In 
alto a destra ci sono le schede per i 
livelli, i canali e così via, e in basso a 
destra tra le altre cose ci sono le schede 
per i pennelli. GIMP ha un sistema di 
disposizione molto flessibile in cui 
potete spostare gli elementi da una 
parte all'altra. 
Per esempio, 
se voglio 
avere i miei 
livelli su una 
finestra a 
parte, posso 
fare clic sulla 
linguetta 
Livelli (in alto 
a destra e qui a destra) e portarlo sul 
mio desktop. 

Se voglio tornare alla disposizione di 

partenza, posso 
fare clic sulla 
parola Livelli 
della finestra e 
trascinarla di 
nuovo in alto a 
destra (a 

sinistra).

Potete 
farlo con 
quello che 
volete - 

quindi sentitevi liberi di configurare 
l'ambiente di lavoro come vi più vi 
piace. Se, per sbaglio, chiudete una 
qualsiasi finestra e la volete 
rivedere, fate clic su File > Finestre 
e quindi sull'elemento che volete 
rivedere oppure nascondere 
all'occorrenza (sopra).
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Creiamo una nuova immagine. Nel 
menu principale, fate clic su File > 
Nuovo. Prima di andare avanti, 
lasciatemi spiegare cosa fanno alcuni 
strumenti. 

Nella parte alta della finestra 
(sopra), dove c’è scritto Modelli, 
possiamo scegliere tra diverse 
dimensioni già configurate. Fate clic 
sul menu a tendina e scegliete A4. 
Sotto a questo campo trovate 
Dimensione immagine. Adesso è 
impostato su quello che avete 
appena scelto, A4, quindi non c'è 
bisogno di modificare ancora questi 
parametri. Alla destra di Altezza il 
valore è il tipo di misura. Al momento 
il mio è impostato su pixel, ma se 
voglio, con un clic sul menu a tendina 
posso cambiarlo in millimetri. Sotto 

Larghezza e Altezza ci sono due piccoli 
pulsanti. Se guardate più da vicino, le 
icone sui pulsanti dovrebbero aiutarvi a 
capire che quello a sinistra imposta 
l'immagine in Verticale (Portrait) e l'altro 
in Orizzontale (landscape). Per adesso, 
lo lascio su Verticale. Un breve riepilogo 
delle opzioni scelte è alla destra di 
questi due pulsanti. Se facciamo clic su 
Opzioni avanzate, sveliamo altre scelte.

Primo, abbiamo i valori X e Y della 
risoluzione. Questi specificano quanto 

sarà dettagliata l'immagine. Questo 
è anche conosciuto come Punti per 
pollice (DPI) ed è fondamentale 
nella stampa. Le tipografie 
professionali di solito chiedono 
almeno 200 dpi, ma la maggior 
parte 300 dpi. Vicino ai valori 
potete vedere una piccola icona 
fatta da anelli di una catena. Nella 
mia immagine, gli anelli sono 
chiusi, che significa che cambiando 
il valore X, automaticamente 
cambia anche il valore Y; facendo 
clic sull'icona si aprono gli anelli, 
così che X e Y possono avere valori 
diversi. Se la vostra icona mostra 
gli anelli della catena aperti, potete 
fare clic sull'icona per impostarli 
come mostrato sull’immagine 
sopra. Per una immagine base di 
prova, cambiate il valore di X o Y a 
100. Il prossimo è Spazio colore. Io 
ho solo due opzioni Colore RGB e 
Scala di grigi e quindi lo lascio su 
Colore RGB. Riempi con vi 
permette di scegliere un colore 
iniziale per la vostra immagine. 
Infine Commento che salverete 
insieme al vostro file GIMP, che 
potrebbe essere qualsiasi cosa 
dall'informazione sul copyright a 
vostri dettagli per contatti.
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Con le mie opzioni impostate, 
faccio clic su OK. 

Adesso ho una nuova immagine 

su cui lavorare. Ma come si lavora su 
un'immagine? Approfondiremo 
questo dettaglio più avanti; per 
adesso faccio un veloce riepilogo di 
alcuni degli strumenti più importanti. 

Quando fate clic su ognuno degli 
strumenti, le opzioni degli strumenti 
(sotto gli strumenti) cambiano. Ogni 
strumento ha le sue opzioni, di cui 
non voglio parlare adesso, ma solo 
fare un giro, perché è così che 
imparerete meglio!  è il Redattore di Full 

Circle Magazine, un’orgoglioso utente 
Kubuntu, e artista part-time, la cui 
galleria di lavori può essere vista su 
 www.RonnieTucker.co.uk.

Perché non provate GIMP 
2.4? E’ disponibile per 
Linux, Mac & Windows.

Date un'occhiata al vostro Gestore 
pacchetti per una facile installazione 
di GIMP, oppure scaricatelo da: 

www.gimp.org

Windows: www.gimp.org/windows

Mac: www.gimp.org/macintosh

Il prossimo mese nella seconda parte, 
vedremo la correzione del colore e la 
modifica del colore. 

http://www.RonnieTucker.co.uk
http://www.gimp.org
http://www.gimp.org/windows
http://www.gimp.org/macintosh
http://www.gimp.org
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HHOOWW--TTOO UUSSAARREE  GGIIMMPP  --  PPaarrttee  22
Scritto da Ronnie Tucker

La correzione del colore (o 
regolazione in qualche caso) è 
probabilmente più associato alla 

fotografia che qualsiasi altra cosa - 
quindi fate una foto e correggete 
qualunque problema di colore possa 
esserci.

Quella sopra è la foto originale. In 
primo luogo, useremo GIMP per 
correggere automaticamente 

Questo mese ci concentreremo soprattutto sui colori, ma lasciatemi dire anzitutto che GIMP (come Photoshop) può raggiungere lo stesso risultato in 
modi diversi. Sebbene vi mostro un solo modo per compiere un'operazione, state sicuri che ci sono molti altri modi per ottenere lo stesso risultato.

l'immagine; quindi la cambieremo 
manualmente. Per aprire un'immagine, 
andiamo su File > Apri, e scegliamo 
l'immagine che vogliamo manipolare. 
Quindi, adesso che abbiamo la nostra 
foto aperta in GIMP, andiamo sul menu e 
scegliamo Colori > Livelli.

Questa 
finestra (a 
destra) ci 
permette di fare 
molte cose complicate, ma noi faremo 
solo clic sul bottone "Auto". Voilà! Una 
foto con colori corretti (a destra). 

Non è sempre così semplice 
realizzare correzioni soddisfacenti. Se 
un oggetto della foto è troppo 
luminoso, per esempio, GIMP 
potrebbe pensare che sia bianco. 
Così, GIMP lo trasforma in bianco, 
corregge il resto della foto di 
conseguenza, e produce un risultato 
terribile. Comunque, nella maggior 
parte dei casi la funzione "Auto" 
produce risultati soddisfacenti. 
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Quando non lo fa, allora si dovrebbero 
applicare correzioni manuali.

Prima che facciate correzioni 
manuali, dovete sapere come sono 
colorate le immagini. In pittura, i tre 
colori primari sono rosso, blu e giallo. 
Da questi, si può creare qualsiasi altro 
colore. Le immagini digitali, 
ovviamente, sono fatte 
(prevalentemente) dalla luce, e i suoi 
tre colori primari sono rosso, verde e 
blu, chiamati comunemente RGB. Non 
mi credete? Fate clic (o mostrate) la 
finestra "Canali", e vedrete tre oggetti - 
uno rosso, uno verde e uno blu.

Questi tre "canali" costituiscono i 
colori nella vostra immagine. Provate a 
fare clic sulla piccola icona a forma di 
occhio a fianco di ogni strato, e vedrete 
come appare la foto senza uno (o più) 
colori di base. Quindi, in sostanza, una 

foto colorata male avrà una combinazione 
di troppo (o non abbastanza) rosso, verde 
o blu.

Fate clic (o visualizzate) la linguetta 
Dialogs > Colori , quindi fate clic sul 
bottone Triangolo: 

Qui sopra c'è l'equivalente digitale della 
ruota dei colori dell'artista (cerchio con un 
triangolo all'interno) con i tre colori primari 
ai vertici del triangolo, che si mescolano 
uno con l'altro attorno al cerchio, con 
scuro e chiaro rappresentati dal triangolo. 
Fate clic su un colore nella "ruota", e il 

triangolo punterà ad esso. Adesso, 
fate clic dentro al triangolo per 
ottenere una versione più scura o più 
chiara del colore. Giocateci per un 
po' per fare pratica su dove sono i 
colori e come ottenere quelli che si 
vogliono - useremo questo più tardi 
quando avremo bisogno di creare o 
scegliere un colore. 

Diamo un'occhiata ad alcune delle 
opzioni per il colore in GIMP per 
vedere come possono modificare la 
nostra immagine. Andate sul menu 
Colori , e scegliete Bilanciamento 
colore (sotto). 

Questa finestra vi permette di 
tarare finemente i colori della vostra 
foto. Può modificare i colori in ognuno 
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dei tre principali livelli: scuri (shadow), 
mezzi toni (midtones) e luminosi 
(highlight). Selezionate Shadows, 
Miftones o Highlight, e muovete i 
controlli per vedere come questi 
modificano la foto.

Se non vedete cambiamenti ai 
colori della foto, controllate che sia 
spuntata casella a fianco di 
"Anteprima". Se non volete tenere 
questi cambiamenti di colori, 
semplicemente fate clic su "Annulla", 
e la vostra immagine tornerà normale. 
Potete anche usare la funzione 
Modifica > Annulla.

Colori > Colora vi permette di 
colorare tutta la foto con un colore 

particolare. Questo è usato soprattutto 
per dare alla foto un "color seppia" che fa 
sembrare l'immagine vecchia e 
degradata. Invece che darvi controlli per il 
rosso, il verde e il blu, questa finestra vi dà 
un controllo del colore che va dal rosso, 
passa per il verde, e va al blu e ancora al 
rosso. Armeggiate con il controllo fino a 
quando ottenete un bel colore arancio-
marrone e vedrete cosa intendo per "color 
seppia". 

Colori > Luminosità-contrasto vi 
permette di schiarire o scurire l'immagine. 
Questo può risultare utile per semplici 
effetti. Se schiarisco un po' l'immagine, e 
alzo un po' il contrasto, posso cambiare la 

cupa immagine originale come se 
fosse stata fatta in un caldissimo 
giorno di sole (anche se sicuramente 
non lo era!).

Abbiamo già visto i "Livelli", ma 
diamo un'altra occhiata da vicino. 
Fate clic su Colori > Livelli, e vedrete 
la solita finestra: sì, quella con il 
magico bottone "Auto", ma questa 
volta focalizziamoci sui controlli sotto 
il grafico. I controlli nero, grigio e 
bianco possono muoversi da sinistra 
a destra, e rappresentano 
rispettivamente gli scuri, i mezzi toni 
e i luminosi. Permettono di 
correggere manualmente i colori 
dell'immagine. "Livelli di uscita" è 
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 è il redattore di 
 magazine, orgoglioso utente 

Kubuntu, e artista a tempo perso, la 
cui galleria può essere visitata su 
 www.RonnieTucker.co.uk.

quasi come il controllo della 
luminosità, ma con tre controlli per 
scuri, mezzi toni e luminosi. Sulla 
finestra in alto c'è un menu a tendina 
con scritto "Valore", potete fare clic su 
questo e selezionare uno dei canali 
rosso, verde o blu per tarature finali. 
Questa è una finestra abbastanza 
potente, quindi potete giocarci un po' 
per prenderne confidenza. E ricordate: 
se vedete che l'immagine non cambia 
quando spostate i controlli, spuntate la 
casella "Anteprima".

Colori > Curve è simile alla finestra 
Livelli (di cui abbiamo appena parlato), 
ma usa curve, tracciate su un grafico, 

per darvi più controllo sui vostri colori. 
Di nuovo sulla finestra in alto c'è un 
menu a tendina, che vi permette di 
modificare l'immagine nel suo 
insieme, oppure modificare uno dei 

canali del colore. Per modificare le curve, 
fate clic sulla curva (per creare un punto), 
quindi muovete il punto su, giù, a destra o 
sinistra per modificare i colori. La più facile 
correzione di colore nella finestra curve, è 
la "S - curve", in cui fate una curva a forma 
di "S". Ancora, questo dà più o meno lo 
stesso risultato del bottone "Auto" di Colori 
> Livelli.

Colori > Desaturazione rimuove tutti i 
colori dalla vostra foto, lasciando 
l'immagine in bianco e nero. Avete tre 

opzioni prima di rimuovere i colori, ognuna 
delle quali dà risultati leggermente diversi, 
quindi è meglio provare ciascuna per 
vedere quale preferite. Come sempre, 
provate un'opzione; se non vi piace, usate 
Modifica > Annulla per tornare all'originale.

Colori > Inverti vi dà il negativo della 

foto, proprio 
come 
l'otterreste con 
pellicola per 
foto 
tradizionale. 
Facendo ancora 
clic su Colori > 
Inverti 
l'immagine 
torna 
all'originale. 

Ci sono moltri altri elementi nel 
menu Colori, ma quelli di cui ho 
parlato sono i più importanti, e 
probabilmente i più usati. 

http://www.RonnieTucker.co.uk
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HHOOWW--TTOO UUSSAARREE  GGIIMMPP  --  PPaarrttee  33
Scritto da Ronnie Tucker

Nel precedente articolo, vi ho 
mostrato come modificare i colori di 
una intera immagine. Adesso vi 

descriverò come alterare le parti 
selezionate di un immagine, lasciando il 
resto intatto. Lo faremo utilizzando gli 
strumenti di selezione (sotto).

Da sinistra a destra, i primi due bottoni 
selezionano rispettivamente un rettangolo 
o un ovale (tenere premuto il tasto Shift per 
un cerchio perfetto). Il terzo bottone apre 
uno strumento di selezione libera per 
tracciare il contorno di porzioni di 
un'immagine. Provatelo. Fate clic sull'icona, 
poi tenete premuto il tasto sinistro del 
mouse e disegnate i contorni di un pezzo. 
Quando rilascerete il bottone del mouse, 
vedrete una zona selezionata per essere 
modificata (destra).

Adesso tutte le modifiche interesseranno 
solo la zona selezionata. Questo metodo 
utile, non è però efficace per selezioni 
precise. Il prossimo è la selezione "fuzzy". 

Quando viene fatto clic su un punto, questo 
strumento aumenta 
la selezione finché 
incontra un colore 
diverso. 
L'ingrandimento 
della selezione può 
essere impostato 

con cura modificando il valore soglia nelle 
opzioni (sotto le icone). Si possono selezionare 
pìù colori possono per ampliare la selezione, 
tenendo premuto il tasto Shift. Una volta 
effettuata la selezione, le successive modifiche 
riguarderanno solo l'area selezionata (destra).

Il prossimo è lo strumento selezione colore. 
È simile allo strumento di selezione "fuzzy", 

quindi passiamo 
(per adesso) subito 
all’ultimo: lo 
strumento di 
selezione forbici. Si 
tratta di uno 
strumento più 

preciso della selezione a mano libera 
citata in precedenza, ma funziona bene 
solo con oggetti con contorni ben definiti. 
Il metodo è questo: fare clic per iniziare a 
selezionare e posizionare un punto sul 
contorno; fare ancora clic per posizionare 
un altro punto su una zona più lontana del 
contorno; lo strumento forbici intelligenti 
tenterà di determinare il perimetro 
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dell'oggetto (sopra). Continuate a fare clic 
sul contorno: un numero maggiore di punti 
aggiunti vuol dire una maggiore precisione 
della selezione. L'ultimo clic dovrebbe 
coincidere con il punto di partenza. Prima di 
utilizzare la selezione, ogni punto può 
essere cliccato e spostato per perfezionare il 
contorno.

Per creare la selezione fare clic dentro il 
cerchio completo (vedere sotto). 

Per rimuovere la selezione andare nel 

menu Selezione > Nessuna. 

Ma come ottenere una selezione 
perfetta? Lo strumento Penna (l'icona sotto).

Questo strumento permette la creazione 
di una curva ancora più precisa 
dello strumento forbici. Primo, 
fare clic sullo strumento penna 

per aprirlo, poi fare clic intorno al perimetro 
dell'oggetto o della zona che si vuole 
selezionare come fatto per lo strumento forbici. 
A differenza di quest'ultimo però con lo 
strumento penna non serve chiudere la 
selezione facendo clic sul punto di partenza, 
ma basta fare clic vicino ad esso. Non 
preoccupatevi se un punto è leggermente fuori 
posto, dopo avere inserito tutti i punti, ognuno 
può essere selezionato e spostato (sotto).

Adesso i punti posso essere modificati per 

ottenere tra loro le curve ottimali. Tenendo 
premuto il tasto Ctrl fate click su un punto 
tenendo premuto il tasto del mouse. Una linea 
apparirà da quel punto e si formerà una curva 
tra il punto selezionato ed uno dei punti da 
entrambi i lati (in alto a sinistra).

Ogni punto può avere due linee che arrivano 

da una curva (in alto a destra). Quindi fate 
click sul punto tenendo premuto Ctrl e 
trascinate la seconda linea. Così avete 
ottenuto una curva.

Il punto iniziale può ancora essere 
mosso, ma facendo clic e trascinando uno 
dei quadrati alla fine di una linea si può 
impostare al meglio una curva o creare 
una curva nuova a partire da uno dei 
punti o da una linea dritta sull'altro lato. 
Quest'ultimo è stato molto utile 
nell'immagine dell'esempio, nella zona 
dove i gradini incontrano la porta di casa.

Quando tutti i punti sono al loro posto e 
siete 
soddisfatti 
dalle curve, 
dite a GIMP di 
selezionare 
l'area. Per fare 
ciò fate click su 
Tracciati (sotto 
la scheda 
Livelli). Se non 
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si trova lì, visualizzatela facendo click su 
Finestre > Tracciati. Il tracciato appena 
creato è visualizzato in miniatura nella 
scheda Tracciati. Fate clic con il tasto destro 
sul nome del tracciato e scegliete "Crea 
selezione da tracciato".

Fate clic sull'icona a forma di occhio per 
nascondere il tracciato e lavorare sulla 
selezioni o per mostrarlo nuovamente.

Usare lo strumento di selezione assieme 
agli strumenti per la correzione del colore 
può rivelarsi davvero utile, specialmente se 
si ha bisogno di ritoccare foto di famiglia o 
scatti fatti in vacanza.

Qualche volta è necessario usare lo 
Zoom per ottenere una selezione ancora 
più precisa. Lo strumento di Zoom è molto 

 è il redattore di 
, un fiero 

utente Kubuntu ed un artista part-
time. Potete visitare la galleria 
delle sue opere su 
www.RonnieTucker.co.uk.

utile per questo tipo di 
operazioni. C'è un 
menu a tendina in 
basso nella finestra 
dell'immagine (sotto) 
che fornisce un 
accesso veloce ad una 

serie di impostazioni per aumentare o diminuire 
lo zoom di un'immagine.

Lo strumento Zoom (a sinistra) è 
accessibile anche dalla finestra 
strumenti sulla sinistra.

Con lo strumento Zoom, fate clic 
sull’immagine per ingrandirla (tenendo 
premuto il tasto Ctrl e facendo clic, l’immagine 
si riduce). In alternativa è possibile fare clic, 
tenere premuto il tasto e selezionare solo una 
zona dell'immagine (sotto) da ingrandire (in alto 
a destra).

Non dimenticatevi di combinare gli 
strumenti. Ad esempio, per selezionare una 
parte dell'immagine, prima ingrandite con lo 

strumento Zoom, poi scegliete lo 
strumento di selezione che preferite.

http://www.RonnieTucker.co.uk
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Scritto da Ronnie Tucker

Questo mese parleremo della 
funzione forse più potente di 
GIMP: i livelli. Quando capirete 

il concetto di livelli e riuscirete a 
lavorarci, potrete creare qualunque 
cosa.

Innanzitutto assicuriamoci di avere 
attiva e pronta all'uso la nostra 
finestra dei livelli. 

Se non visualizzate la scheda dei 
livelli, fate clic 
nel menu 
principale su File 
> Finestre > 
Livelli. 

Vediamo come 
lavorano i livelli. 

Pensate a ciascun livello come a un 
foglio di plastica trasparente. L'idea è 
che voi disegnate tutte le vostre 
diverse cose su fogli di plastica 
separati, poi li impilate in un preciso 
ordine per ottenere il risultato voluto. 
Un po' come lavora un animatore. Lo 
sfondo sta su un foglio, il 

personaggio su un altro foglio ed ogni 
particolare in primo piano su un terzo 
foglio. Sovrapponeteli in maniera 
appropriata e otterrete il personaggio e 
sopra di lui il primo piano. La stessa cosa 
avviene con i livelli di GIMP.

Se aprite un'immagine in GIMP e 
visualizzate la scheda (o la finestra) dei 
livelli, vedrete che l'immagine sarà 
mostrata su un singolo livello di nome 
"Sfondo".

Sotto l'elenco dei livelli vedrete 

diverse icone. Sono un po' come 
delle scorciatoie delle voci di menu.

Da sinistra a destra sono: Nuovo 
livello, Alza livello, Abbassa livello, 

Duplica livello, Ancora livello e 
Cancella livello. Mi sembrano 
abbastanza chiari da sé.

Tramite gli strumenti di selezione, 
di cui abbiamo parlato nell'articolo 
del mese scorso, userò lo 
strumento di selezione ellittica per 
selezionare il pianeta.
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Dal menu scelgo Modifica > Copia 
e quindi Modifica > Incolla.

Adesso ho un nuovo livello (col 
nome "Selezione fluttuante"), ma 
deve essere fissato: fate clic 
sull'icona Nuovo livello. Adesso avrà 
una sua icona di anteprima che 
viene automaticamente chiamato 
"Livello incollato". Se volete 
rinominare un livello, basta fare 
doppio clic sul suo nome e inserire 
un nuovo nome, quindi premete il 
tasto Invio.

Se nascondo l'immagine originale 
"Sfondo", vedrete che il pianeta 
selezionato, copiato e incollato sta su un 
livello suo, completamente separato. È il 
nostro primo nuovo livello!

 Potete copiare da 
una immagine e incollare in un'altra 
immagine.

Non fate caso allo sfondo a scacchi: 
sta a indicare solo la completa 
trasparenza.

Adesso, col pianeta selezionato, farò 
clic sull'icona Duplica livello per creare 
un secondo pianeta. Per spostare i livelli 
usate lo strumento Sposta, selezionate il 
livello che volete spostare, fate clic e 
spostatelo. Userò alcune delle nostre 
tecniche di modifica del colore per 
cambiare quello di un pianeta: sarà più 
facile per voi distinguerli.

 Se avete due 
immagini aperte, potete trascinare 
un livello da un'immagine all'altra!

Creiamo un nuovo livello vuoto. 
Verrà creato un nuovo livello sopra 

il livello attivo: 
quindi 
seleziono il 
livello Sfondo 
(che è 
nascosto) e 
faccio clic 
sull'icona 
Nuovo livello. 
Appare la 

finestra Nuovo livello (qui sopra).

Dall'alto in basso: diamo al livello 
un Nome (meglio qualcosa di 
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 è redattore di 
 magazine, orgoglioso utente 

Kubuntu e artista a tempo perso, la 
cui galleria d'arte può essere visitata 
su .

descrittivo! Il mio lo chiamerò 
"Spazio"); Larghezza e Altezza per 
ora non ci interessano, dato che 
vogliamo il livello grande quanto 
l'immagine; lasceremo il Tipo di 
riempimento livello come 
trasparente. Potete scegliere bianco 
o uno dei colori di primo piano o di 
sfondo. Ora, sceglierò il nero come 
colore di primo piano e riempirò il 
mio livello "Spazio" con il nero.

In 
questo 
modo ho 
due 
pianeti 
nello 
spazio. 
Non mi 
serve più 

l'immagine originale: seleziono il 
livello e faccio clic sul'icona Cancella 
livello.

E se volessi, ora, il pianeta 
arancione davanti a quello blu? 
Faccio clic sul livello del pianeta 
arancione e quindi sull'icona Alza il 
livello.

Pensate ai vostri livelli come se 
andassero dal basso verso l'alto. 
GIMP, infatti, dapprima mette il 

livello "Spazio"; su di esso pone il livello 
col pianeta blu e, infine, su di esso il 
livello del pianeta arancione.

Quando salvate, assicuratevi di farlo 
nel formato di GIMP (XCF). La prossima 
volta che aprirete l'immagine troverete 
tutti i livelli pronti per essere lavorati. 
Salvare in JPG o PNG appiattirà 
l'immagine e perderete le informazioni 
sui livelli: tenete sempre una versione in 
XCF! Per salvare il file, fate clic nel menu 
su File > Salva 
come... e 
assicuratevi che il 
nome del file 
finisca in .xcf (qui 
a destra).

Si possono 
applicare molti effetti ai livelli per 
renderli anche più potenti. Provate a 
spostare il cursore dell'Opacità (sopra 
l'elenco dei livelli).

Ogni livello può essere applicato 
secondo proprie Modalità, elencate 
nel menu a discesa sopra il cursore 
dell'Opacità. Fate qualche prova 
con questi effetti. Potreste trovare 
degli effetti carini.

Queste sono le basi sui livelli. 

Senza 
dubbio ci soffermeremo ancora su 
di loro nei prossimi articoli, ma per 
ora fate delle prove copiando e 
incollando, alzando i livelli, 
abbassandoli e spostandoli per dare 
vita a una composizione piacevole.

http://www.RonnieTucker.co.uk
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Scritto da Ronnie Tucker

Questo mese parleremo di 
dimensioni. GIMP può usare 
diversi tipi di misure per le 

immagini. Create una nuova immagine 
selezionando File > Nuovo ed 
esaminiamo qualche tipo di unità di 
misura.

Se non potete vedere la selezione di 
risoluzione X e Y, fate clic sul testo Opzioni 
avanzate sotto Dimensione immagine.

A fianco di Dimensione immagine potete 
vedere i valori di larghezza e altezza. Alla 
destra del valore dell’altezza vedete un 
menu a tendina. Nel mio caso visualizza 
“pixel”. Semplicemente, i pixel sono i piccoli 
punti che compongono lo schermo. Quindi 
in questo caso l’immagine sarebbe larga 
640 pixel (o “punti schermo”). Selezionate il 
menu a tendina per vedere le altre opzioni. 
Adesso, provate a selezionare pollici.

Avete visto i valori cambiare? Adesso è 
larga solo 8,889. Perché? Perché adesso 

misuriamo in 
pollici. 8,889 pollici 
è la stessa 
larghezza di 640 
pixel.

Perché ci sono 
diversi tipi di 
misure? Se state 
lavorando su un 
banner che sarà 

utilizzato su un sito internet, per 
esempio, dovrete creare la vostra 
immagine in pixel, diciamo larga 400 e 
alta 50 pixel. Ma per una stampa su 
carta, la vostra immagine potrebbe 
essere larga 8 pollici e alta 12 pollici. 
Passate da un'unità di misura all’altra 
quando necessario.

Proprio sotto il testo Opzioni 
avanzate c’è la risoluzione X e Y. 
Questa è impostata in modo 
predefinito a 72 pixel per pollice, 
chiamata anche “dots per inch” (DPI), 
ed è sufficiente per la maggior parte 
degli schermi di computer e per lavori 
sul web. Pensate a DPI come il 
dettaglio. Più punti per pollice, più 
dettagli si possono mettere 
nell’immagine. Attenzione che, 
ovviamente, un DPI alto può rallentare 
qualche PC e il file risultante avrà 
dimensioni molto più grandi. Per lavori 
di stampa su carta si dovrebbe 
impostare a 300 circa, ma controllate 
prima con chi stamperà l’immagine. 
Nel dubbio, usate 300 DPI.
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Allora, con la nuova immagine 
(sotto), passiamo ai righelli.

Lo noterete, in alto e a sinistra della 
nuova immagine, ci sono i righelli 
indicanti la misura in uso, i pollici nel mio 
caso. Questo consente la misurazione e 
la disposizione precisa degli oggetti 
nell’immagine. Immaginate quante 
prove dovrei fare ed errori, se avessi 
bisogno di un cerchio che parte ad un 
pollice dal bordo in alto e un pollice da 
destra, prima di farlo correttamente. 
Sarebbe quasi impossibile! Ma con i 
righelli possiamo essere molto più 
precisi. Selezionate col mouse il righello 
orizzontale in alto e portatelo in fondo 
all’immagine.

Vedrete apparire una riga orizzontale 
(o righello) sulla vostra immagine 
(sopra). Questo righello non danneggia 

la vostra immagine in nessuna maniera, è 
solo una linea guida e può essere spostata 
facendo clic sopra e spostandola con lo 
strumento di movimento. Riportatela 
dov’era per rimuoverla completamente. 
Noterete che la riga informativa in fondo 
all’immagine vi dice esattamente dov’è il 
righello sulla pagina (verticalmente in 
questo caso). Spostate il righello sinistro 
(verticale) sulla pagina per ottenere un altro 
righello un pollice da sinistra (sopra).

Il punto in cui questi due righelli si 
incrociano è da dove dovete far partire il 
vostro cerchio (riquadro).

Mi fido di GIMP, 
davvero. Ma 
facciamo la parte 
"dell'avvocato del 
diavolo" e 
controlliamo un’altra 

volta, usando uno strumento diverso, 
per assicurarci che ci sia davvero un 
pollice tra il righello e il bordo 
dell’immagine. Per questo abbiamo 
bisogno dello strumento di 
misurazione (misurino) (in basso a 
sinistra).

Questo strumento è come un metro 
a nastro. Potete fare clic per 
creare un punto di inizio e 
fare clic per creare un punto 
di fine (sotto). Viene creata 

una linea rossa tra i due punti. Sulla 
barra di informazione (ancora, sotto 
l’immagine) vedrete alcuni numeri. 
Questi rappresentano la lunghezza 
della linea, l’angolo della linea, la 
larghezza della linea (dal punto di 
inizio al punto di fine) e l’altezza della 
linea (di nuovo, dal punto iniziale al 
punto finale).
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Dallo strumento di misurazione posso 
vedere che il righello è un pollice. Buon 
lavoro GIMP! Selezionando qualsiasi 
altro strumento si rimuoverà il nastro di 
misurazione dal video.

Un ultimo strumento da approfondire 
in questa sezione è lo 
strumento ritaglio (sinistra) 
che risulta comodo per 

tenere una sola parte rettangolare di 
un’immagine.

Selezionare lo strumento ritaglio, 
quindi fate clic e selezionate un’area 
intorno all’area che volete tenere (sotto).

Questa area può essere mossa, 
selezionando e spostandosi col mouse 
all’interno dell’area, o ridimensionata, 

 è editore di 
, un fiero utente Kubuntu, artista a 

tempo perso la cui galleria di lavori può 
essere vista su www.RonnieTucker.co.uk. 

selezionando uno degli angoli interni 
dell’area. Notate come l’area esterna si 
scurisce per focalizzare la vostra attenzione 
all’interno della selezione. Usate lo 
strumento ritaglio per togliere aree non 
interessanti attorno alle foto. Fate clic 
all’interno dell’area per ritagliare l’immagine.

Vedete come ritaglire l’immagine forza 
voi, gli osservatori, a focalizzarsi sullo 
scalino del patio. Prima magari eravate 
distratti dalle pietre del pavimento. Se 
qualcosa non è necessario in una foto, 
tagliatela via.

Aiutaci a tenere a 
bada i bug.

Unisciti a Launchpad.net

http://www.RonnieTucker.co.uk
http://launchpad.net
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Questo mese proseguiamo con 
alcune funzionalità avanzate di 
GIMP. Questo gruppo di funzioni è 

usato principalmente per ritocchi 
fotografici (noti anche come air-brushing) 
sia per correggere, sia per migliorare 
un'immagine.

Cominciamo con un semplice 
fotoritocco: i maledetti occhi rossi. Questi 
appaiono quando il flash della macchina 
fotografica illumina l'interno del bulbo 

oculare, facendo 
apparire la pupilla rossa 
anziché nera.

Il modo più semplice 
per correggere gli occhi 
rossi è andare nel menu 
Filters > Enhance > Red-
Eye Removal. Questo vi 

darà un'anteprima dell'immagine e un 
controllo per ottimizzare la rimozione degli 
occhi rossi.

Ma aspettate, sta modificando parti 
dell'immagine che non sono le pupille! 
Questo perché anche le labbra sono rosse. In 
realtà, tutto quello che GIMP sta facendo è 
cambiare i pixel rossi in neri. Quindi dobbiamo 
essere più selettivi con questa immagine. 

Utilizzate lo strumento di selezione 
rettangolare per disegnare un riquadro 
attorno ad entrambi gli occhi, quindi 
provate il filtro “Rimozione occhi rossi”.

Molto meglio. Solo state attenti di non 
esagerare con le funzioni di controllo, 
scurireste le sue sopracciglia rossicce.

HHOOWW--TTOO
Scritto da Ronnie Tucker UUSSAARREE  GGIIMMPP  --  PPAARRTTEE  66

FCM n. 12 - n. 16 : USARE GIMP 1 - 5

GraphicsDev Internet Multimedia System

HardDriveCD/DVD USB Drive Laptop Wireless



17

Un altro modo per rimuovere gli occhi 
rossi è quello di creare semplicemente un 
altro livello, disegnare dei punti neri per 
ogni pupilla e quindi moltiplicare il livello 
coi punti per l'immagine originale finché 
non appare sistemata. Ma il filtro 
“Rimozione occhi rossi” è una scorciatoia 
veloce e carina.

Il nostro 
prossimo 
volontario è una 
celebrità che, in 
questa foto, 
appare un po' 
diciamo 
"consumata 
dall'uso". 
Aiutiamola: ha 
bisogno di 
togliere quelle 

orrende macchie.

Lo strumento “Healing” 
(cura ndt) vi permetterà di 
scegliere un punto (nessun 
gioco di parole voluto!) 

nell'immagine come riferimento. GIMP 
quindi cercherà di rendere uguale quello 
che finisce sotto il vostro pennello, 
tenendo conto del punto di riferimento. 
Prima selezionate l'icona dello strumento 
Healing. Vedrete due cerotti incrociati 

vicino al vostro puntatore con un simbolo 
"accesso vietato" (un cerchio con una linea 
diagonale che lo attraversa). Questo significa 
che non avete ancora definito un punto di 
riferimento. Tenete premuto CTRL e il simbolo 
"accesso vietato" svanirà. Selezionate 
qualche parte vicino alla macchia e quindi 
rilasciate CTRL. Vedrete ora un cerchio con 
una croce all'interno a marcare il punto di 
riferimento.

Ora, semplicemente disegnate sopra la 
macchia vicina e, se il punto di riferimento è 
buono, la macchia svanirà. A volte avrete 
bisogno di annullare quello che avete fatto 
con lo strumento Healing e riprovare, ma 
provare e sbagliare non fa mai male.

E, come qualsiasi 
buona crema per 
rimuovere i punti 
neri: applicate al 
bisogno!

Adesso la nostra 
celebrità è pronta 
per la copertina.

Prima di 
iniziare a 
indicarmi, no, 
non sono io 
nella foto! É mio 
nonno e la foto 
fu scattata nel 
1930, circa, 

quindi è un po' malandata e ha bisogno 
di qualche ritocco.

Per questo potremmo 
utilizzare facilmente lo 
strumento Healing, ma, 

questa volta, introdurremo il potente 
strumento Clone. Avrà bisogno, come lo 
strumento Healing, di un punto di 
riferimento, ma questa volta clonerà 
semplicemente il punto di riferimento 
dove metterete il pennello, nessun 
lavoro di confronto. Quindi proviamolo: 
stessa idea, selezionate lo strumento 
Clone, tenete premuto CTRL, 
selezionate la sorgente (vicino ad uno 
strappo nella foto), rilasciate CTRL e 
siete pronti a rimuovere i danni.
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 è editore di 
, utilizzatore 

orgoglioso di Kubuntu e artista 
part-time la cui galleria di lavori può 
essere vista su www.RonnieTucker.co.uk.

E, giusto per dimostrazione, provate lo 
strumento Healing su alcuni strappi della foto. 
Probabilmente funzionerà allo stesso modo, 
ma è sempre meglio avere un piano B!

http://brainstorm.ubuntu.com

Pensate a Wine come a un livello di 
compatibilità per avviare programmi 
Windows. 

, visto che è una 
implementazione alternativa delle API 
di Windows completamente gratuita 
costituita al 100% da codice non 
Microsoft.

Il Database di Applicazioni Wine 
(AppDB) è dove potete ottenere 
informazioni circa la compatibilità delle 
applicazioni con Wine.

http://appdb.winehq.org/

http://www.RonnieTucker.co.uk
http://brainstorm.ubuntu.com
http://appdb.winehq.org/
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Questo mese analizzeremo i 
numerosi Filtri di GIMP e daremo 
un'occhiata al menu Xtns 
(estensioni). Entrambi i menu 
consentono un rapido accesso a 
dozzine di effetti speciali. La 
principale differenza tra i due è 
che le voci presenti in Xtns 
creeranno una nuova immagine 
con l'effetto selezionato. I filtri 
possono essere applicati all'intera 
immagine o ad una selezione.

Il menu Xtns si trova a lato del 
menu File. Vedrete voci come Module 
Manager e Script-Fu, ma a noi 
interessano le voci Bottoni, Loghi, 
Misc, Motivi e Temi Pagine Web. 
Un'altra limitazione di queste 
estensioni è che la maggior parte di 
esse, se non tutte, non sono 
interattive. In altre parole: è un po' un 
andare a tentoni, tra prove ed errori.

Selezionate Xtns -> Logos -> Chrome.

Apparirà una finestra 
contenente le opzioni disponibili 
per questa estensione Chrome.

Come potete vedere, non ci 
sono molte opzioni. Potete 
scegliere un carattere e una 
dimensione, un colore di sfondo 
e del testo a cui applicare 
l'estensione. Io ho scelto un 
carattere massiccio e ho usato il 
testo "Full Circle", ed ecco il 
risultato:
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Nonostante avessi selezionato due 
tonalità di giallo, continua a restituirmi 
un effetto cromo nero. Cosa dovrei fare 
se volessi modificare il testo? Magari 
avvicinare le lettere? Mi dispiace ma 
non è possibile. Le estensioni sono 
script predefiniti. Per ottimizzare 
l'effetto, è necessario andare nella 
cartella /usr/share/gimp/2.0/scripts, 
copiare lo script e modificarlo con il 
vostro editor di testo preferito. Non 
molto semplice come utilizzo. Questa è 
una delle ragioni per cui non li utilizzo 
mai. Tuttavia volevo presentarli 
velocemente per poi ignorarli. 
Procediamo con i più utili e intuitivi Filtri.

Utilizzerò 
la fotografia 
a sinistra 
come punto 
di partenza.

Facciamo 
un salto 

dentro e applichiamo un filtro all'intera 
immagine. Selezionate Filtri > 
Sfocature > Gaussiana.

Così come per le estensioni, apparirà 
una finestra. Questa finestra contiene 
l'anteprima e i controlli per il filtro 
selezionato.

Nella parte alta 
della finestra c'è 
l'anteprima, che 
può essere 
attivata, o 
disattivata, 
selezionando la 
casella sotto 
l'anteprima. Sotto 
di questa trovate il Raggio di sfocatura per 
applicarne quanto ne vorrete all'immagine. 
A fianco dei numeri vedrete una piccola 
icona con tre maglie di catena, questa 
collega i valori orizzontali e verticali: 
modificatene uno e l'altro cambierà di 
conseguenza. Scollegare i valori vi darà 
più un effetto movimento (dato che quello 
orizzontale o verticale avrà più disturbo 
dell'altro), ma per ora li lascerò collegato 
con valore sette. Potete specificare a quale 
unità di misura si riferisce il valore (pollici, 

millimetri, pixel, ecc.). Io preferisco 
pixel. Poi ci sono due metodi di 
sfocatura, ma per ora non li 
cambiamo. Dopo, premo OK per 
applicare l'effetto.

Una foto sfocata. Adesso facciamo 
ricorso alla nostra bravura nel 
selezionare solo una parte di 
immagine da sfocare. Utilizzerò lo 
strumento tracciato per creare 
rapidamente una selezione da 
sfocare.
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Adesso, quando applico la sfocatura, 
avrà effetto solo sull'area selezionata.

Sfocare solamente lo sfondo (e non 
la cornice della porta) ha dato un'idea 
di profondità, come se la camera si 
fosse concentrata sul telaio della 
finestra. Giochiamo con altri filtri.

Filtri > 
Miglioramento 
è quello dove 
abbiamo usato 
Rimozione 
occhi rossi 

nell'articolo del mese scorso. In questa 
serie di filtri uso spesso Affilatura. 
Questo filtro ha un cursore che vi 
permette di aumentare il dettaglio 
dell'immagine (o di una selezione). 
Questo è uno dei primi effetti che 
applico ad un'immagine per 
correggerla.

Filtri > 
Distorsioni > 
Rilievo è utile per 
evidenziare 
dettagli che 
inizialmente non 

potete vedere.

Mentre 
Increspature vi 
permetterà di 
rendere una 
selezione come 
se fosse liquida.

Molto 
probabilmente 
uno dei più usati 
(e abusati) effetti 
applicati ai media 
oggi è Proietta 
ombra. Si trova 

sotto Filtri > Luce e ombra > Proietta 
ombra, prenderà una selezione (o un 
livello di testo, in realtà qualsiasi cosa) e 
aggiungerà un'ombra sotto. Può 
effettivamente aiutare a sollevare un 
oggetto dalla pagina, ma può risultare 
davvero banale. È anche uno dei pochi filtri 
senza anteprima. Filtri > Luce e ombra ha 
molti altri potenti effetti come Effetti luce 
che può aiutare a dare all'immagine 
un'atmosfera.

I filtri denominati Artistici 
cercheranno di applicare un effetto 
pittura. Filtri > Artistici > Pittura ad 
olio cercherà di trasformare la vostra 
foto in un dipinto ad olio.

Ci sono troppi effetti per poterli 
elencare in questo breve articolo. La 
chiave è sperimentarli. Giocare con 
essi per vedere cosa producono. Non 
abbiate paura a dare loro valori alti o 
bassi. A volte il caso dà i migliori 
risultati!

Il prossimo mese prenderemo tutto 
quello che abbiamo imparato nei 
sette mesi scorsi e combineremo 
diverse fotografie per ottenere con 
una fantastica opera d'arte GIMP. Ma 
prima di allora, permettetemi di citare 
le Maschere di livello.

Normalmente, quando cancelliamo 
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una parte di un livello, è persa per 
sempre. Con le maschere di livello 
possiamo rimuovere delle parti da un 
livello, ma solo visivamente, mentre il 
livello originale è ancora lì, senza 
modifiche. Ciò è inestimabile se, più 
tardi, decideste di voler reintegrare una 
parte del livello. Questo è possibile con 
le maschere di livello, impossibile con il 
cancellino.

Immaginiamo che voglio cancellare 
le scale dalla mia foto. Primo, 
selezionate il livello che sarà 
interessato, adesso andate su Livello > 
Maschera > Aggiungi maschera di 
livello.

Apparirà una finestra e vorrà una 
risposta. Scegliere Bianco (opacità 
completa) manterrà l'immagine così 
com'è e vi permetterà di dipingere 
quello che volete rimuovere. Questo è 
quello che scelgo la maggior parte 
delle volte.

Noterete che, a 
lato del livello 
selezionato, è 
apparsa una 
nuova miniatura 
(un quadrato 
bianco). Questa è 
la vostra 
maschera. È 
completamente 
bianca al 

momento e completamente visibile.

Ecco (brevemente) come funzionano le 
maschere: il bianco è completamente 
opaco e visibile, il nero è completamente 
trasparente e le tonalità di grigio 
intermedie saranno semi trasparenti. 
Assicuratevi che sia selezionata la 
miniatura della maschera, scegliete lo 
strumento pennello e utilizzate il nero per 
dipingere. Se avete selezionato la 
maschera di livello, allora nasconderete 
parti del livello, non cancellandole, ma 
nascondendole. Per dimostrare il concetto, 
premete il tasto destro sulla miniatura 
della maschera di livello e selezionate 

Disabilita maschera di livello.

Vedrete ritornare il vostro livello allo 
stato iniziale. Selezionate 
nuovamente Disabilita maschera di 
livello per riabilitare la maschera.

Le maschere di livello sono 
strumenti veramente potenti e vi 
danno molta flessibilità, lasciando 
sempre disponibili i vostri livelli per 
modifiche future. Pensate a questo 
come avere una torta e mangiarla.

 è Capo 
redattore della rivista 

, fiero utilizzatore di 
Kubuntu e artista part-time, la cui 
galleria di lavori può essere vista su 
www.RonnieTucker.co.uk.

http://www.RonnieTucker.co.uk
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In questo ultimo articolo della serie 
dedicata a GIMP, vedremo come creare 
un'unica immagine utilizzando tre 

fotografie prese da Flickr. Sebbene il risultato 
finale non farà impazzire un attento 
osservatore di fotografie, la sua creazione 
dovrebbe aiutarvi a mettere in pratica tutto 
quello che avete appreso nei precedenti 
sette articoli. Una cosa che ho già 
provveduto a fare è la registrazione in tempo 
reale dei trenta minuti occorsi per la 
creazione dell'immagine, che potrete vedere 

su Google Video all'indirizzo:

http://url.fullcirclemagazine.org/c44b86

Come prima cosa, ho trascinato sul mio 

computer le tre immagini originali, facendo 

attenzione a scegliere soltanto foto rilasciate 

sotto licenza Creative Commons ShareAlike, che 

autorizza a modificare le fotografie stesse. Quello 

che sto pensando è di prendere il cielo sullo 

sfondo di una foto, un soggetto a distanza media 

da un'altra foto e possibilmente un primo piano 

da una terza, oppure l'uno o l'altro o ancora 

aggiungervi eventualmente dell'acqua con i filtri 

di GIMP. Aggiungerò i link alle foto che ho 
utilizzato alla fine dell'articolo, qualora voleste 
seguirmi passo passo.

Con le tre immagini aperte in GIMP, ho creato 
una nuova immagine con le stesse dimensioni di 
quelle di partenza. Io ho usato le immagini di 
anteprima di Flickr, perché non volevo avere 
troppe foto di dimensioni elevate durante la 
registrazione dello schermo, ma voi potete usare 
le fotografie in tutta la loro grandezza. Nel caso si 
lavori con paesaggi, conviene andare dalla zona 
più lontana a quella più vicina, con il cielo 
utilizzato come l'elemento più lontano sul fondo, 
per cui ho disegnato una linea di selezione molto 
irregolare attorno al cielo della mia prima 
fotografia. Ho copiato questa selezione e l'ho 

incollata nella mia nuova immagine.

Quindi ho deciso di utilizzare la catena 
montuosa della seconda fotografia e ho 
selezionato il suo contorno utilizzando lo 
strumento Penna. Dopodiché ho di nuovo 

copiato ed incollato la selezione nella mia 

nuova immagine.
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Dalla terza foto ho selezionato gli alberi e il 

prato e li ho copiati e incollati anch'essi nella 

nuova immagine.

Per dare profondità alla figura, ho creato 

un nuovo livello e l'ho posizionat tra quello 

con la montagna e quello con gli alberi. 

Quindi con l'aerografo ho dato in alcuni punti 

un tono di bianco che potesse dare l'idea di 

nebbia o foschia. Poi ho selezionato gli alberi 

più lontani e gli ho applicato un Blur 

Gaussiano.

Avevo anche una quarta foto che avevo 

pensato di usare, ma ho deciso di lasciar perdere. 

Quello che ho fatto è stato invece copiare il livello 

con il cielo, rifletterlo verticalmente, fare una 

selezione con lo strumento Penna e cancellare 

parte di esso. Ci applicheremo sopra alcuni effetti 

in modo da farlo diventare uno specchio d'acqua.

Anche le montagne devono essere riflesse, 

per cui ho fatto con il loro livello la stessa identica 

cosa: l'ho copiato e riflesso verticalmente.

Prima di applicare l'increspatura 

all'acqua, ho utilizzato un pennello morbido 

e la gomma per attenuare il profilo della 

montagna. Quindi ho appiattito i due livelli 

(il riflesso della montagna e quello del cielo) 

in un unico livello e ho applicato l'effetto di 

increspatura.

Ho scurito il primo piano dell'acqua 

utilizzando lo strumento Brucia. A quel 

punto però, mi sono reso conto che non 

avevo riflesso l'albero in primo piano! 
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 è Capo 
redattore della rivista 

, fiero utilizzatore di 
Kubuntu e artista part-time, 

la cui galleria di lavori può essere 
vista su www.RonnieTucker.co.uk.

Quindi ho fatto una breve selezione 

dell'albero in questione, copia/incolla su un 

nuovo livello, riflesso verticalmente e 

applicato l'effetto increspatura anche ad 

esso. Fortunatamente il filtro usato per 

l'increspatura mantiene le impostazioni 

dell'ultima volta in cui è stato utilizzato, per 

cui l'increspatura sull'albero è la stessa 

utilizzata per l'acqua.

Tutti i componenti dell'immagine finale 

sono al loro posto. A questo punto, ho 

cominciato a giocare un po' con alcuni filtri 

per vedere se qualcuno di essi potesse 

migliorare la fotografia. Ho provato il Lens 
Flare e Sparkle, ma nessuno ha avuto un 
effetto apprezzabile. Ho provato il Gradient 
Flare su un nuovo livello e ha dato l'idea che 
fosse presente il sole, quindi l'ho tenuto e ho 
giocato un po' con gli effetti del livello per 
miscelarli al meglio.

http://url.fullcirclemagazine
.org/2fba72

http://url.fullcirclemagazine
.org/8a00d5

http://url.fullcirclemagazine
.org/d31f07

Immagini di partenza:

video della realizzazione dell'immagine: http://url.fullcirclemagazine.org/c44b86

http://www.RonnieTucker.co.uk
http://url.fullcirclemagazine.org/2fba72
http://url.fullcirclemagazine.org/8a00d5
http://url.fullcirclemagazine.org/d31f07
http://url.fullcirclemagazine.org/c44b86
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N
el primo articolo di questa
nuova serie di GIMP proverò
a mostrarvi alcune tecniche
di livello intermedio. In altre

parole, cose che la gente può pensare
siano possibili solo con Photoshop. Se
volete leggere di più sulle nozioni di base
di Gimp vi rinvio ai numeri di FCM 1 2-29.
Dato che in quei numeri usavo una
versione più vecchia di GIMP, il layout è
cambiato un po' negli anni trascorsi.

Per le idee, userò dei tutorial di
Photoshop che sono liberamente

disponibili sul web e, dato che non li
copierò passo per passo, applicherò i
loro principi basilari a GIMP.

Per la cronaca, dovrei anche dichiarare
che sto usando GIMP 2.6. Mentre scrivo è
disponibile una versione 2.7 ma non è
interamente compatibile con la famiglia
*buntu e cercare d'installarla può dare
dei conflitti.

Ciò che faremo è mostrato a sinistra.

Fonti:
Cielo -
http://www.2textured.com/index.php/E
nvironment/Skies/skies_0347

Video su Youtube che mostra come
viene fatta la Parte 1 :
http://www.youtube.com/watch?v=NYF
Tdbzjubg

Il Gradiente Cielo

La prima cosa che dobbiamo fare è
creare una nuova immagine (File >
Nuovo) e farla nella dimensione A4,
orientamento verticale e con la
risoluzione di 80 per X e Y. La risoluzione
predefinita di X e Y è 300. Questa è per
la stampa professionale e richiede come
materiale sorgente immagini ad alta

risoluzione e può rallentare anche la più
tosta delle macchine; per questo
procederemo con 80 che è più che
adeguata per questo tutorial.

Selezionate l'icona “Strumento
sfumatura” (mostrata a
sinistra) e, dove dice, 'Forma:'
scegliete 'radiale' dal menù a
discesa. Non c'è bisogno di

cambiare nient'altro per adesso. Per il
colore di primo piano scegliete un
verdino-giallastro molto pallido
(RGB=220,229,1 89). Per il colore di

sfondo scegliete un verdino-giallastro

un po' sbiadito (RGB=1 33,1 51 ,81 ).

Dopo fate clic (e tenete premuto) col
tasto sinistro in mezzo all'immagine
vuota e spostatevi verso la metà
superiore dell'immagine. Rilasciate il
tasto del mouse e avrete un
riempimento radiale che coprirà l'intera
tela.

No, non i livelli!

http://www.2textured.com/index.php/Environment/Skies/skies_0347
http://www.youtube.com/watch?v=NYFTdbzjubg
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Fate clic su File>Apri e scegliete la vostra
immagine del cielo. Per avere
rapidamente il cielo nella vostra
immagine principale andiamo alla scheda
'Livelli' e, come mostrato sopra,
trasciniamolo nella nostra immagine
principale.

Adesso, con il cielo nella nostra
immagine principale, potete chiudere
l'immagine cielo aperta.

L'immagine del cielo ha una
risoluzione piuttosto alta, più
grande di quanto abbiamo

bisogno, così dobbiamo ridimensionarla.
Fate clic sullo strumento 'Scala'
(mostrato a sinistra) e fate clic sul cielo.
Nella finestra di ridimensionamento che
apparirà dovrete assicurarvi che l'icona
con la catenella sia unita. Se l'icona ha

l'aspetto di una catena rotta, allora la
vostra immagine del cielo si
ridimensionerà sproporzionatamente e si
schiaccerà. Rendete la larghezza del cielo
ampia circa 300 e fate clic su OK. Ciò vi
darà dello spazio con cui giocare.

Fate clic sull'icona 'Sposta'
(mostrata a sinistra). Adesso
fate clic sinistro e trascinate

l'icona col cielo dove pensiate stia
meglio.

SUGGERIMENTO: I l gradiente è un
livello e il cielo è un altro. Se
aggiungiamo parecchi altri livelli
diventerà piuttosto confuso. Per rendere
le cose più facili potete fare doppio clic
sul nome di un livello e rinominarlo.

E adesso un po' di magia del livello. Con il

livello del cielo ancora selezionato, fate
clic sul menù a discesa sopra i livelli e
scegliete 'Valore'.

Curve di colore

Adesso avrete un cielo verdino ma non
sembra molto drammatico, vero? Con il
livello cielo ancora selezionato, fate clic
sul menù Colori > Curve. Creeremo ciò
che è conosciuto come curva ad S. La
curva ad S è anche un modo fantastico di
fare rapidamente la correzione del
colore alle vostre foto. Nella griglia fate
clic sul punto della diagonale distante
due caselle dal margine alto e due da
destra e trascinate il mouse verso l'alto e
un po' a sinistra, poi clic sul punto della
diagonale distante due caselle dal basso
e due dal margine sinistro e trascinate
leggermente verso il basso e a destra.

HOWTO - GIMP: BEANSTALK PARTE 1
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Ciò vi darà una curva ad S (mostrata
sopra) con cui dovreste giocare fino a
che non otterrete un bel cielo
drammatico con buone zone scure ma
non troppe luci brillanti.

Terminiamo questo cielo, è tutto ciò che
faremo per questa prima parte del
tutorial.

Maschera di livello

Fate clic col tasto destro sul livello cielo
e, dal menù, scegliete 'Aggiungi
maschera di livello' (mostrato sotto).

Dalla finestra che apparirà scegliete

'Bianco (opacità completa)' e fate clic su
'Aggiungi'. Vedrete apparire una casella

accanto alla miniatura del cielo
nell'elenco dei livelli.

Quella casella è una miniatura della
maschera di livello. L'idea è che se voi

selezionate quella miniatura del livello e
ci disegnate in nero, cancellerete parti
dell'immagine del cielo. Disegnate col
bianco sull'area cancellata e il cielo
riapparirà. Ciò significa che potete
mostrare/nascondere parti del cielo,
utilizzando la maschera, senza
distruggere l'immagine originale del
cielo. Useremo la maschera per far
svanire il cielo nello sfondo.

Assicuratevi che la miniatura
della maschera sia
selezionata, essa dovrebbe
avere un bordo bianco, e fate

clic sull'icona “Selezione rettangolare”
(mostrata sotto a sinistra). Fate clic con

tasto sinistro e disegnate una casella
intorno al terzo inferiore del cielo.

Adesso fate clic sull'icona dello
'Strumento sfumatura' (che abbiamo
usato all'inizio di questo tutorial) ma
questa volta assicuratevi che la 'Forma:'
sia Lineare. Avrete bisogno di un colore
di primo piano nero e di un colore di
sfondo bianco. Selezionato tutto ciò,
fate clic e trascinate poco sopra il bordo
in basso della metà inferiore dell'area
selezionata, fermandovi poco sotto la
parte alta della metà superiore, e
rilasciate il tasto del mouse.
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Ronnie è il fondatore e l'editore di
Full Circle, un membro ufficiale di
Ubuntu e un artista part-time il cui
lavoro può essere visto su:
http://ronnietucker.co.uk
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I l vostro cielo adesso svanirà
magicamente nello sfondo. E, dato che è
una maschera di livello, il cielo originale è
intatto. Potete fare clic col tasto destro
sul livello maschera e cancellarlo e il cielo
ritornerà al suo stato originale.

Il mese prossimo aggiungeremo un
pezzo di paesaggio sotto il cielo e forse,
solo forse, inizieremo a far crescere
quella pianta di fagioli. Classe
congedata!

I l Podcast Ubuntu copre tutte le
ultime notizie e novità che si
presentano agli utenti di Ubuntu
Linux e ai fan del software libero in
generale. La rassegna è rivolta tanto
all'utente più fresco quanto al
programmatore più esperto. Le
nostre discussioni riguardano lo
sviluppo di Ubuntu ma non sono
eccessivamente tecniche. Siamo
abbastanza fortunati da avere
qualche gradito ospite nello show a
passarci novità di prima mano sugli
ultimi eccitanti sviluppi a cui stanno
lavorando, in modo comprensibile a
tutti! Parliamo inoltre della comunità
Ubuntu e di cosa le interessa.

Lo show è offerto dai membri della
comunità Ubuntu Linux del Regno
Unito. Ed essendo coperta dal Codice
di condotta di Ubuntu è adatta a
tutti.

Lo show è trasmesso live ogni due
settimane il martedì sera (ora
inglese) ed è disponibile per il
download il giorno seguente.

podcast.ubuntu-uk.org

http://www.youtube.com/watch?v=NYFTdbzjubg
http://ronnietucker.co.uk
http://podcast.ubuntu-uk.org/
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O
K, quindi abbiamoottenuto
il nostro cielo colorato e che
sfuma nello sfondo; come
prossimopasso, vogliamo

avere un piccolo villaggio sotto il cielo.

Sorgenti:
Villaggio:

http://www.sxc.hu/browse.phtml?f=view
&id=1215281

Albero:
http://alfoart.com/flash/beanstalk_tutori
al/625100_53361668.jpg?http://www.2te
xtured.com/main.php?g2_itemId=281

Youtube:
http://www.youtube.com/watch?v=KTm
ehu8x2j4

IlVillaggio

Importiamo la foto del villaggio nella
nostra scena. Come?Con questo sto
verificando se avete letto la prima parte o
meno. Stesso concetto: apriamo la foto
del villaggio e trasciniamola nella nostra
scena principale. Probabilmente però si
dovrà ridimensionare la larghezza a 750
pixel.

Si dovrebbe vedere qualcosa di simile
a questo, niente panico.

Se osserviamo la lista dei livelli,
vedremo che il livello del villaggio è
stretto a sandwich tra il cielo e l'immagine
di sfondo. Dobbiamo invece porre il livello
in cima alla lista. Basta semplicemente
trascinarlo sopra il livello del cielo.

Selezioniamo l'icona Sposta e
trasciniamo il livello del villaggio verso la
parte bassa dell'immagine.

Taglieremovia qualche albero di
troppo alle spalle del villaggio per
ottenere un belpanorama.

Selezioni

Gli strumenti di selezione sono una
delle cose più importanti in GIMPperché
permettono di essere precisi quanto
occorre perselezionare un tracciato. Per
questo nostro primo grande tutorial,
procederemo con una selezione tanto
rapida quanto grossolana.

Facciamo clic su 'Strumento di
selezione libera' (mostrato a sinistra) e
disegniamo attorno alla zona alberata,
mantenendo solo gli alberi che si vedono

per intero. Continuiamo a
disegnare fuori dai lati
dell'immagine e chiudiamo la

selezione dove l'abbiamo cominciata.
Premere il tasto Invio sulla tastiera per
completare la selezione.

Ovviamente, si può andare in senso
orario se lo si preferisce.

Premendo il tastoCancsulla tastiera
qualunque cosa all'interno della selezione
verrà rimossa.

SUGGERIMENTO: Se premendo il
tastoCanc l'area selezionata diventa nera,
occorre andare sulmenù
Modifica>Annulla modifica. Fare clic con il
tasto destro sull'icona dei livelli e
selezionare 'Aggiungi canale alpha'.
Adesso possiamopremere il tastoCanc
perrimuovere la selezione. Questo passo,
'Aggiungi canale alpha', non è sempre
necessario.

http://www.sxc.hu/browse.phtml?f=view&id=1215281
http://alfoart.com/flash/beanstalk_tutorial/625100_53361668.jpg?http://www.2textured.com/main.php?g2_itemId=281
http://www.youtube.com/watch?v=KTmehu8x2j4
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Se vi piace, potete contornare la linea
degli alberi con lo strumentoGomma,ma
per ilmomento lo copriremo con lo
strumentomaschera. Vi ricordate come

creare un livellomaschera, vero?Esatto,
clic con il tasto destro sul livello del
villaggio e selezione della maschera di
livello bianca.

Usiamo il rettangolo perselezionare la
metà alta del villaggio (sotto, a sinistra) e,
come l'ultima volta, usiamo un gradiente
lineare nero e bianco persfumare la parte
alta del villaggio.

Ricordate l'ultima lezione, quando ho
detto che la maschera di livello non è
distruttiva?Ecco, è l'occasione per
provarlo. Abbiamo creato un livello vuoto
completamente trasparente, quindi
selezioniamo il bianco come colore di

primopiano e l'icona
Pennello (mostrata a
sinistra).

SUGGERIMENTO: Se si ha bisogno di
ingrandire/restringere il pennello, si
possono usare i tasti parentesi quadra
(ovvero [e ]).

L'idea qui (comemostrato in basso a
destra) è di dipingere di bianco (sulla
maschera di livello!) sopra ad alcuni degli
alberi in primopiano perrimuoverli
dall'effetto nebbia sullo sfondo.

OK, vediamodi inserire il nostro
grande e grosso albero e avremo
terminato con la parte due.

Vi mostrerò un altro rapidomodo di
inserire un'immagine. Facciamo clic sul link
proposto sopra per i tre sorgenti. Nel
browser, facciamo clic col destro
sull'immagine aperta e copiamola. Quindi
portiamoci sull'immagine principale in
GIMPe, dalmenu, scegliamo
Modifica>Incolla come>Nuovo livello.
Voilà!

HOWTO - GIMP: BEANSTALK Parte 2
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Ronnie è il fondatore e l'editore di
Full Circle, un membro ufficiale di
Ubuntu e un artista part-time il cui
lavoro può essere visto su:
http://ronnietucker.co.uk

HOWTO - GIMP: BEANSTALK Parte 2
Dovremo ridimensionare il layerad

una larghezza di 600 pixel e spostarlo in
basso peravere le tre radici a metà strada
verso la parte erbosa del villaggio.
Facendo clic su Ridimensiona e quindi
sull'albero, scolleghiamo i parametri di
altezza e di larghezza, visto che ci
interessa solo allungare l'albero
verticalmente portandolo a 650 pixel.

Come abbiamo fatto per il villaggio, è
ora di ritagliare e rimuovere lo sfondo in
eccesso, lasciando solo l'albero. Facciamo
quindi clic sullo strumento di selezione
libera emettiamoci a lavorare.

Stavolta vogliamo tenere quello che
sta all'interno della selezione, quindi nel

menu, facciamo clic su Selezione>Inverti e
premiamoCanc. Un albero.Ma credomi
piacerebbe farlo crescere verso destra,
quindi clic su Livello>Trasforma>Specchia
orizzontalmente. Vorrei anche che avesse
un colore verdastro come il resto
dell'immagine, quindi facciamo clic su
Colori>Colorize emuoviamo lo sliderdella
saturazione finché non riusciamo a
conferire una tinta verde all'albero. Infine,
applichiamo unamaschera di livello
all'albero, selezioniamone il terzo
superiore e utilizziamo lo strumento Fondi
persfumarlo tra le nuvole.

Un'ultima cosa, i compiti a casa per
questa lezione: usate lo strumentoBrucia
sul livello del villaggio perdipingere

l'ombra dell'albero sulprato.

Nella parte finale del tutorial sul
Fagiolomagico aggiungeremoun po' di
vitalità all'immagine.

http://www.youtube.com/watch?v=KTmehu8x2j4
http://ronnietucker.co.uk
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Ronnie è fondatore ed editore di Full
Circle e un artista autodidatta il cui
sito potete trovare su:
http://ronnietucker.co.uk

HHOOWW--TTOO
Scritto da Ronnie Tucker GGIIMMPP -- TThhee BBeeaannssttaa llkk PPaarrttee 33

A bbiamo quasi finito con
l'immagine della pianta di
fagiolo, ma mi piacerebbe
aggiungere qualche cosa in

modo causale, perdargli un po' di brio.

Sorgenti:

Luna:
http://www.sxc.hu/photo/1 1 26941
Stelle:
http://www.sxc.hu/photo/1 005288

Video su YouTube:
http://www.youtube.com/watch?v=HZc
oOx94ox8

Chiarore della luna

Copiamo e poi incolliamo l'immagine
della luna sull'immagine della pianta di
fagiolo. Manteniamo la larghezza del
livello della luna a 1 50 e capovolgiamola
orizzontalmente.

Ora, dalmenu a tendina della lista
dei livelli, scegliamo "Schermo"; lo
sfondo nero del livello scomparirà e la
luna splenderà nella sua bellezza.

Ma un po' di scintillio intorno non
puòmancare. Imbroglieremo sul
bagliore usando un filtro. Facciamo clic
su Filtri > Artistici > Chiarore sfumato.
Muoviamo gli indicatori fino a quando
non troveremo qualcosa che ci possa
piacere. Io ho impostato dei valori alti a
brillantezza e a raggio chiarore.

La cosa buona nel fare ciò in modo
non distruttivo è la possibilità di poter
cambiare qualunque cosa in qualsiasi
momento senza dover rifare
completamente porzioni dell'immagine.
Ora andremo a usare una curva a S
sull'albero, poiché penso che ha bisogno
di un po' di lucentezza e che quella

cavità debba essere resa più carina e

scura.

L'ultima cosa che andremo ad
aggiungere sono le stelle al cielo, quindi
è ora di prendere l'immagine delle stelle.
Posizioniamo il livello sopra quello della
luna e scaliamolo a un'ampiezza di circa
300 pixel. Questa volta però impostiamo
la modalità del livello su "solo toni chiari"
nelmenu a tendina dei livelli. L'ultima
cosa da fare è aggiungere alle stelle una
maschera di livello in modo che vengano
sfumate verso il basso.

Il prossimomese ci sarà un tutorial di
Thomas Standiford su come far
sembrare le foto retrò.

http://www.youtube.com/watch?v=HZcoOx94ox8
http://ronnietucker.co.uk
http://www.sxc.hu/photo/1126941
http://www.sxc.hu/photo/1005288
http://www.youtube.com/watch?v=HZcoOx94ox8
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HH OOWW--TTOO
Scritto da Thomas Standiford GG II MMPP -- FFoottoo RReettrròò

I n questo how-to su GIMP ci
accingiamo a fare qualche
elementare regolazione delle
curve per dare a questa foto un

eccezionale look retrò e stilizzato.

Inizieremo con l' immagine in alto
a destra e finiremo con l' immagine
mostrata in basso a destra.

Ottenere colori Retrò

La maggior parte dell'effetto
per questa foto si ottiene
semplicemente regolando le curve
per ogni canale (il canale rosso,
verde, blu e alfa) in questo modo:

Nota: per scegliere il canale da
modificare, selezionate il canale dal
menu a discesa. Potete andare avanti
e indietro fra i canali. Tutte queste
regolazioni alle curve dovrebbero
essere fatte con UN COMANDO non
una serie di quattro comandi.

Dopo aver fatto la modifica la
vostra foto dovrebbe avere già un
buon aspetto, ma dobbiamo
attenuare un po' il contrasto.

Poi facciamo un'altra
regolazione delle curve in questo
modo:
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HOWTO - GIMP FOTO RETRÒ
Niente male, se non fosse che

queste bolle spariscono durante la
modifica.

Evidenziare le Bolle

Le bolle sembrano essere sparite
nella foto. Utilizzeremo una
combinazione di selezione e pennello
leggero per fare in modo che risaltino.

Create un nuovo livello,
chiamatelo "bolle".

Ora selezioneremo le bolle.
Usando lo strumento tracciati seguite
il contorno di ogni bolla.

Una volta che tutte le bolle sono
state delineate fate clic col tasto
destro sul tracciato nel menu dei
tracciati (posizionato nella stessa
finestra dei livelli) e poi fate clic su
"Tracciato a selezione".

Impostate i vostri foreground e
background ad un verde lime ed un

rosa caldo.

Usando un pennello abbastanza
grande e leggero pennellate
attentamente in alcuni spazi di rosa e
verde in ogni bolla:

Ora che abbiamo aggiunto il colore
alle aree appropriate delle bolle
andiamo a modificare qualche stile di
livello e ad aggiustare l'opacità per fare
in modo che le bolle sembrino reali.

Impostate la modalità del livello a
sovrapposto.

Duplicate il livello e denominate il
livello duplicato "bolleilluminate".

Impostate la modalità del livello a
somma.

Aggiustate l'opacità di entrambi i
livelli "bolle" e "bolleilluminate" fino a
che non sarete soddisfatti. I miei valori
di opacità sono impostati a 23 e 40
rispettivamente e assomigliano a
questo:

Ora che le nostre bolle sono
leggermente più visibili
drammatizziamo un po' la foto.

Ritocchi Finali

Create un nuovo livello e
chiamatelo "drammatizzato",
impostate la modalità del livello a
sovrapposto e riempitelo di nero.

Aggiungete una maschera di
livello al livello "drammatizzato".

Utilizzando lo strumento
sfumatura impostate la forma a
radiale, ed usate un gradiente che
vada dal nero al bianco. Crete un
gradiente che vada dal centro della
foto verso l'esterno. Regolate
l'opacità del livello fino a che il
risultato non vi soddisfa. Ecco il
risultato che ho ottenuto:

Il prossimo mese inizieremo
una serie sul video-editing
usando Kdenlive.
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HHOOWW--TTOO
Scritto da Ronnie Tucker GG''MMIICC II nnPPaa iinntt

Questo mese Nicholas ha lavorato
dal letto di un ospedale, ritornerà
il prossimo mese.

Una delle cose che rende noto
GIMP sono i suoi filtri. Pensate ad
essi come ai plugins di Photoshop.

Un filtro di GIMP incredibilmente
potente, anche se non sembra
ancora ben conosciuto, è G'MIC. La
sigla G'MIC sta per "GREYC's Magic
for Image Computing" e include un
incredibile numero di filtri per
correggere deformazioni,
degradazioni, dettagli, emulsione di
pellicola, pattern, renderizzazioni,
riparazioni e anche una sezione per
filtri ancora in sperimentazione. In
questo piccolo esempio parlerò della
funzionalità Inpaint. Potrete quindi
mascherare un area che Inpaint
coprirà per voi.

INSTALLAZIONE

Andate su:
http://gmic.sourceforge.net/gimp.sh
tml e scaricate il file appropriato
(32/64 bit).

Decomprimete l'archivio nella
vostra directory dei plugin di GIMP
(che solitamente si trova in
/home/.gimp2.8/plug-ins o giù di lì,
dovrete rendere visibili i file nascosti
per trovare la cartella .gimp2.8). Ora,

quando avviate GIMP e cliccate sul
menu "filtri", dovreste vedere G'MIC
alla fine della lista.

USO

Dal momento in cui avete
caricato una foto (in GIMP), usate lo
strumento matita (non il pennello)
per coprire la parte della foto da
rimuovere con Inpaint. Io sono
partito dalla foto mostrata in alto.

http://gmic.sourceforge.net/gimp.shtml
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Ronnie è il fondatore e (ancora!)
editor di Full Circle. È anche un
artista fai-da-te (part-time) che
disegna sia cose serie che frivole. I
suoi lavori possono essere visti
presso: http://ronnietucker.co.uk.

HOWTO - G'MIC INPAINT

Ho deciso di provare Inpaint
vedendo se era in grado di
rimuovere il nastro bianco e rosso. Ci
ho semplicemente disegnato sopra
con lo strumento matita usando il
rosso brillante (rosso puro, niente

verde o blu) come mostrato nella
pagina precedente (immagine in
basso).

In seguito ho aperto G'MIC (filtri >
G'MIC...), cliccato su Repair e quindi

su "Inpaint [patch-based]":

Dalle impostazioni predefinite ho
alzato il Patch Size a 1 5 ed il Lookup
Size a 22. Poi ho premuto OK ed ho
aspettato. Potrebbe volerci un bel

po' di potenza di calcolo per
completare l'operazione, è arrivato il
momento di prendere un tè/caffè.

In basso a sinistra potete vedere
il risultato finale.

È perfetto? No. È più veloce e
facile da usare dello strumento
clona? Assolutamente sì!

Ho scelto appositamente questa
foto perché ho pensato che le
ringhiere sarebbero saltate fuori ma
Inpaint ha funzionato bene. Ci sono
un paio di bit imperfetti sulle
ringhiere, ma vediamo se riuscite a
scovarli da voi.

G'MIC contiene letteralmente
dozzine di grandiosi filtri con cui
potrete giocare!

http://ronnietucker.co.uk

